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2. BACKGROUND
UpStage is a web-based venue for cyberformance[1] - the real-time
compilation of digital media into live performance, by multiple remote
players for an online audience (and sometimes an offline audience as
well). People anywhere in the world can participate in live performance
events by using standard browser software to access UpStage,
without having to download and install additional software and without
needing to know anything other than a web address.
T he concept for UpStage was developed by Avatar Body Collision, a
globally dispersed cyberformance troupe whose members have been
experimenting with online theatrical performance since 1999, and
together as Avatar Body Collision since 2002. UpStage was born from
the desire to reach a wider audience and to make it easier for
audiences and performers alike to participate in live performance via
the internet.
T he software combines the different elements of cyberformance graphical avatars, web cams, audio, images, text chat (and who knows
what else in the future) - into a single interface. T he audience simply
directs their browser to the web address at the appointed time, to
watch and participate in the cyberformance.
T he UpStage server application is open source and free to download.
It is available under dual licensing: a Creative Commons AttributionNonCommercial-ShareAlike 2.5 License and GNU General Public Licence
(GPL).
T he initial development of UpStage was funded in 2003 through the
Smash Palace Collaboration Fund, a joint initiative of Creative New
Zealand and the NZ Ministry of Science, Research and T echnology. In
2006, the UpStage project received funding from the Community
Partnerships Fund of the New Zealand government’s Digital Strategy to
develop UpStage version 2. UpStage V2 was also supported by
partners CityLink, MediaLab and Auckland University of T echnology.
Currently, UpStage is supported by CityLink who provide free server
hosting and traffic, and Auckland University of T echnology who
provide teams of final-year computer programming students to work
on the ongoing development of the software. T he UpStage team and
user community are very grateful for this vital support.
T his is the user manual – it provides general instructions for using
UpStage version 2.1; it is divided into 6 sections:
Introduction
Audience
Players
Media Management
Creating Media
Appendices
Open sessions are held regularly in UpStage, providing training in the
basic use of UpStage and how to create cyberformance. For dates and
times for the next open session, visit www.upstage.org.nz and join the
UpStage Announce list.
If you are looking for technical support including instructions for
installing the UpStage server, please refer to the SourceForge trac and
the developers' mailing list.
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For further information and updates, please visit www.upstage.org.nz.

T he UpStage User Manual has been edited by Helen Varley Jamieson in
collaboration with Vicki Smith and the UpStage community, and is
licensed under a Creative Commons Attribution-NonCommercialShareAlike 3.0 Unported License.

[1] Cyberfo rmance uses internet techno lo gies to bring remo te perfo rmers to gether in
live theatrical events; www.cyberfo rmance.o rg
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3. PROJECT TEAM
T he UpStage project was initiated in 2003 by Avatar Body Collision,
who are Vicki Smith, Leena Saarinen, Karla Ptacek and Helen Varley
Jamieson. T he project continues to be managed by Helen Varley
Jamieson and Vicki Smith. For more information about the Colliders,
please visit www.avatarbodycollision.org.
T he UpStage application was originally written by Douglas Bagnall, who
has a background in open source development of online projects, and
is also a digital artist. His artistic work includes the development of a
film-making robot and a cloud-classifier; visit http://halo.gen.nz/.
At the end of 2010, former AUT student Paul Rohrlach joined the team
as a developer and server administrator and in 2011 Francesco
Buonaiuto became our volunteer documenter. Many other artists are
involved in the annual UpStage Festival, and we have a growing team
of open source developers who are supporting the maintenance and
development of the software.
Since December 2004, the UpStage server has been generously hosted
by Citylink.
T hanks to Anne Philpott, we established a relationship with Auckland
University of T echnology. which has seen teams of final year software
development students working on UpStage as their major project since
2006.
T he AUT UpStage teams to date are:
2012-13: Scott Riddell, Gavin Chan & Craig Farrell
2012: Benjamin Qin and Daniel Han
2011-12: Nessa Baterina, Karena Goh, Corey Robb
2011: Heath Behrens and Vibhu Patel
2010-11: Mohammad Al-T imimi, JR Malonzo and Henry Goh
2010: T om Choi, Paul Rohrlach & Craig Farrell
2009-10: Natasha Pullenster, Nicholas Robinson and Shaun
Narayan
2009: John Coleman and Vishaal Solanki
2008-09: Shaun Nesbitt, Wendy Wen, Candy Yang
2008: Aaron Barnett
2007 -08: Alan Crow and T ony Wong
2007 : Endre Bernhardt, Lauren Kilduff & Phillip Quinlan
2006-07 : Beau Hardy, Francis Palma, Lucy Chu and Wise Wang.
Many other people have contributed to the development of UpStage
through encouragement, advice, user testing, feedback, and simply
believing that it was possible. T he project team thanks every one of
you.
If you are interested in being a part of the development of UpStage,
you can join the developer list,
https://lists.sourceforge.net/lists/listinfo/upstage-list.
If you would like to be kept informed about events in UpStage, you
can join the announcements list:
https://lists.sourceforge.net/lists/listinfo/upstage-announce.
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4. TECHNICAL INFORMATION
UpStage is a server-side application. T his means that it runs on a webserver, and the users of UpStage (players and audience) access it via a
web browser; you do NOT install UpStage on your own computer
(client). If you have access to a web server and wish to install your
own, customisable, version of UpStage, please refer to the installation
manual and other support available on the SourceForge site.
Upstage is written in Python, using the T wisted framework for eventdriven asynchronous networking. It doesn't require Apache (or MYSQL
or anything else). T he client is written in pure Actionscript, and is
compiled using Mtasc, so there is no requirement for Macromedia
software other than the Flash player plug-in on the client computer.
Words typed in by the players are converted into speech using the
Fesitval speech library, eSpeak and MBROLA, and streamed to the
clients as MP3s.
T he server runs on Debian Linux, but should easily convert to other
platforms. Python and T wisted are cross-platform, but there is a line
or two of shell scripts that tie in the speech synthesis.
T he software has been worked on since June 2003 and contains some
8000 lines. Please visit our SourceForge site to find the latest stable
version and installation documentation.

CLIENT HARDWARE & SOFTWARE REQUIREMENTS
If your computer has a browser with the Flash player plug-in, then you
already have everything you need to use UpStage. Obviously faster
processors and higher RAM give improved performance, but UpStage
has been designed to work on relatively low-spec client machines.
A broadband internet connection will give the best performance, but
UpStage performs surprisingly well over dial-up. T he main
disadvantage when using dial-up is that the load time for each stage is
longer. You may need to allow up to 15 minutes to load a stage,
depending on how many graphics are on it. Once it’s loaded, the realtime interaction and overall performance of UpStage is not
dramatically worse on dial-up than on broadband.
UpStage has been designed to run on a wide range of clients using the
Macromedia Flash Player plug-in (version 7 or above). It should function
properly in all standard browsers such as Firefox, Safari, Internet
Explorer and Opera.
Linux users may need to install gsfonts and gsfonts-x11 (see the section
T roubleshooting for information about this).

FIREWALLS
UpStage will function through most but not all firewalls, depending on
how the firewall has been set up.
If you install your own UpStage server, it will ask you to specify which
ports you want to use (the defaults are 8081 and 7 230). You will need
to ensure that your users have the correct ports open.
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T he Open UpStage server uses ports 8084 and 7 230-7 233, therefore
these ports need to be open if you are trying to access this server
through a firewall. T hese ports are open by default in most private
internet connections, but some organisational networks will close any
“unnecessary” ports.
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AUDIENCE
5. AUDIENCE VIEW
6. AUDIENCE CHAT
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5. AUDIENCE VIEW
Audience members enter UpStage by following a web link from an
email or another web page, and participate in the performance via the
text chat. Audience members do not need to download or install any
additional software as long as they have a browser with the Flash
player plug-in. Audience members do not log in, and therefore do not
have access to the same on-stage tools as Players do.
A splash screen covers the stage while it loads, preventing the
audience from interacting until the stage is fully loaded. Once the stage
has loaded, the audience will see any graphics that have already been
placed on the stage, they will see and hear the performance, and they
will be able to participate in the text chat.
T he audience view of the stage is shown below: the text chat window
is at the right, with an input field at the bottom and up-down scroll
arrows on the right top and bottom corners. T he rest of the screen is
the "stage" where the visual action of the performance takes place.
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6. AUDIENCE CHAT
Audience members are also known as “chatters”, because they can
interact with the performance by typing into the text input field at the
bottom right of the screen. T his text appears in the text chat window,
amongst the Players’ text. Player text is slightly darker and larger than
audience text, and identified with the avatar’s name. Audience text is
grey, silent and anonymous.

T he screengrab above, from West Side's Story (101010 UpStage Festival)
shows audience and player text in the chat.
T he audience chat has a life of its own. Often at the beginning of a
performance, audience members will ask where other people are
physically located and have conversations between each other. During
the performance, the audience can respond to and commentate on the
action of the performance, embellish the narrative or provide a
counterpoint. Obviously every audience is different, making every
performance significantly different - sometimes an audience may be
very quiet but at other times very chatty.

REPRESENTING THE CHAT
Audience text can also be used by players within the performance,
such as repeated or responded to in the performance. Another
effective incorporation of audience chat into the performance is the
projection of chat text and its subsequent capturing and representation as a web cam image.
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T he screengrab above is from Belonging (Avatar Body Collision, 2007 )
and shows the representation of text from the chat window in a
webcam avatar.

COMMANDS
Audience members can use a number of commands in the text chat;
these are instructions typed into the text chat input field after a / , for
example:
/asize 8 (or another number): this changes the font size of audienceinput text to 8 (the default size is 4) on that computer. T his is useful
for people with visual impairment and if the screen is being projected
for a group audience.
/psize 8 (or another number): this changes the font size of player-input
text, as above.
/info: gives some information about UpStage.
Players have a lot more commands available to them - see the chapter
on Commands for more information.
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7. LOGGING IN
Players log in to UpStage to create and present performances. They do
not need anything other than a browser with the Flash player plugin to do
this.
Note that audience members do NOT log in to UpStage; their view of
the stage is different to that of logged in players. Players watching
performances by other players are advised to log out first so that
they experience the performance as it's intended to be viewed,
without the distraction of the on-stage player tools.
T here are two levels of player log-in: "player only" and "admin". T he
player-only log-in is used for guests and new users, and gives access
to the on-stage player tools but not to the Workshop. T he admin login gives access to the Workshop as well, meaning that the player can
upload and edit media, and create and manage stages. Having a
player-only log in helps to reduce the incidence of inexperienced users
uploading unuseable media.
For the UpStage Open Server, 8084, players can log in at
http://upstage.org.nz:8084 or at http://upstage.org.nz:8084/admin. Once
logged in they will find themselves in the Foyer, a customisable landing
page that provides links to existing stages and to the media management
tools.
Players can change their own passwords and edit other information in
their profile.
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8. PLAYER VIEW
Players log in to UpStage to create and present performances. They do
not need anything other than a browser with the Flash player plugin to do
this.
T wo levels of logging in: as "player only" which gives access to the onstage player tools (described above) or "admin" which also gives
access to the workshop.
Once logged in, they have access to the Workshop area where they can
upload and manage the media to be used on stage, and to the on-stage
tools that enable them to manipulate media for a performance.
T he"player view" of the stage is different to the "audience view".

The Wardrobe (top right hand corner) is a scrollable list of the avatars
that have been assigned to this stage. The Mirror (the square beside the
Wardrobe) shows the avatar you are currently holding, with its name in
the rectangle under the mirror. There are tools below the Mirror, and
image galleries for backdrops and props along the bottom of the stage
area. Players see a smaller text chat window than the audience.
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9. ON-STAGE PLAYER TOOLS
Logged-in players have access to a range of on-stage tools, not visible
to the audience, which enable the real-time manipulation of preloaded
media and live elements on the stage.

HOLDING AND MOVING AN AVATAR
T he avatars assigned to a stage appear as small icons in the
Wardrobe. T o hold a particular avatar, click on its icon in the Wardrobe
(use the arrows to scroll up and down the Wardrobe). T he icon will
disappear from your Wardrobe and appear in your Mirror, the square
area to the left of the Wardrobe. T his shows you which avatar you are
currently holding. A greyed-out icon in your Wardrobe means that
another player is holding that avatar.
Once you have an avatar in your Mirror, click on the stage area and
your full-size avatar will appear there. Click in another place, and it will
move there.

Tools
T he Player tools are the set of buttons below the mirror, and the
green arrows in the mirror. T hese arrows allow you to move your
avatar in front of and behind other avatars on the stage.
Fast/Slow

T his button controls the
avatar movement – fast
causing the avatar to jump
to where you click, and
slow causing it to glide
there. T he button shows
the action that the avatar
will change to when next
clicked – for example if
your avatar is gliding, the
button will show fast. Click on it to change to fast, and the button will
become orange and say “slow”.
Stop

When your avatar is gliding (in slow mode), click on stop to stop it at
any point in its trajectory.
Name

T his button will hide or show your avatar’s name on the stage – this is
particularly useful when working with invisible avatars. When you first
hold an avatar, the default state is for the name to be showing, so
click on “name” before you place the avatar on the stage if you don’t
want the name to show.
Draw

T his button changes the function from acting to drawing, displaying
the drawing tools palette instead of the avatar tools. See Section 3.10
for more information about drawing.
Drop

T he drop button will remove your avatar from the stage, and put it
back in the Wardrobe so that you are no longer holding it. If you want
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to leave your avatar on the stage while you operate another avatar,
simply select the new avatar from the Wardrobe without clicking drop.
Clear

Use clear to remove all unheld avatars and props from the stage.
Audio

T his button displays the audio tools palette. See Section 3.11 for more
information about using audio.
Player/Audience counter

Below the control buttons, a counter keeps a live tally of the number
of players (P) and audience (A) present on stage at any time. T yping
/details will list the usernames of the players and the number of
audience in the chat window.

Operating Multi-frame or Animated Avatars
Avatars that have been created as .swf animations, or uploaded as
multiframe avatars, allow you to change the avatar while it is on stage.
Animated Avatars

Created as .swf files, these avatars will animate in the Workshop,
Wardrobe and Mirror. When placed on stage, animated squences will
appear as a still image in the first frame of the animation. T ype /a 0
to start the looped animation, and to display a different still frame
type /a 1 (the default), /a 2, /a 3 etc.
Flash Movieclips will animate on loop without typed-in commands. You
need to create these as movies in Flash – see Section 4.4 for more
information.
Multi-frame Avatars

T hese work in a similar way to the animated avatars, but are created
by uploading a series of still images (in .png or .jpg format) rather than
using Flash.

Changing Your Avatar’s Name

T o change the name of the avatar you are holding, type /nick
newname in the text input field at the bottom of the chat window. You
will see the name underneath your mirror change, and when the avatar
is on stage the new name will appear below it (unless you have used
the “name” button to turn off the name). T he new name will also
appear in the text chat window before the text your avatar speaks.
When using invisible avatars, you can make words float around the
stage by showing the name, and using /nick to change the visible word
on screen. Up to 9 characters will be visible on stage; if you have a
longer name it will all be visible in the text chat.

HOLDING AND PLACING PROPS
T he props assigned to the stage appear as small icons in the Props
Gallery at the centre bottom of the screen.
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When you roll your cursor over the icons, a name label appears,
allowing you to distinguish between similar or very small props. If more
than 8 props are assigned to a stage, arrows will appear at either end
of the bar to allow you to scroll through the props, which are
displayed alphabetically.
You must be holding an avatar and be on stage to hold a prop. Click
on the prop icon in the Gallery, and it will appear at the top left of
your avatar. Click again on the prop icon in the Gallery, and it will
remove the prop from your avatar. If another player clicks on the
same prop that you are holding, it will be transferred to their avatar.

CHANGING BACKDROPS
T he backdrops assigned to a particular stage appear as small icons in
the Backdrops Gallery, at the bottom left of your screen.
Roll your cursor over the icons to display the name label so that you
can accurately choose the backdrop you want. If more than 8
backdrops are assigned to a stage, arrows will appear at either end of
the bar to allow you to scroll through the backdrops, which are
displayed alphabetically.

Click once on the icon to place the backdrop onto the stage; click the
icon a second time to remove it.
Multiframe backdrops can be used in the same way as normal
backdrops; to change the backdrop's frame, type /b 1, /b 2 etc in the
text input field. T ype /b 0 to make the backdrop animate through its
frames.
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10. SPEECH AND TEXT CHAT
To make your avatar speak, type
into the text input field below the
Chat window (bottom right of
your screen) and hit enter (if
there isn’t a blinking cursor line
there already, you may need to
click the mouse there).
Your text will appear with your
avatar’s name in the text chat
window, as well as on the stage
beside your avatar (unless you
have not put your avatar onto the
stage). It will be spoken aloud in
the voice selected for that avatar
(note that you cannot change an
avatar's voice on stage, this must
be done in the avatar edit screen
from the Workshop).
The audience can also type into
the text chat, but their text won't
be spoken out loud and only appears in the text chat window, not on the
stage. As the audience doesn’t log in, there are no names connected to the
audience chat. If you aren’t holding an avatar, your text will appear as
audience text.
You can make your avatar
“think” by typing : (colon)
before the text. Your text will
appear in a thought bubble over
the avatar, but won't be spoken
aloud. It will appear in the text
chat window in blue and with
curly brackets around it (see
image below).

To make your avatar "s hout",
type ! before the text. Your text
will appear in a red-outlined
bubble over the avatar, and in the
text chat window as red
capitalised text. It will be spoken
aloud and the avatar's voice is
subtly modified upwards in pitch.

AVATAR VOICES
UpStage uses the Festival Speech
Synthesiser and MBROLA to generate
text2speech audio for the avatars' voices.
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When you upload a new avatar, you will
arrive at the avatar's edit screen where you
can select its voice from a dropdown menu.
To change the voice of an avatar that has
previously been uploaded, you can access
the edit screen from anywhere where you
can click on the avatar name (e.g. the Manage
avatars screen or the Stage edit screen).
Once you have changed the voice, you will
need to reset the stage(s) it is assigned to for
the change to take effect.
Note that changing an avatar's voice will
change it on all stages that the avatar is assigned to; therefore you should
not change the voice of an avatar that is not yours or that you think other
people may be using on another stage.
See Section 5.5 for more information about available voices,
descriptions, and how to add more.

SAVING THE LOG
The text chat is automatically saved by the server, and can be viewed by
adding “/log” to the end of the URL in the address bar of your browser
(e.g. http://upstage.org.nz:8084/stages/walkthrough/log). You can then
either select “Save as” from your browser’s file menu, or copy and paste
the text into a text file.
Resetting a stage (from the Stage Edit screen in the workshop) will
permanently delete all of the text from the chat log.

WHISPERING
Players can “whisper” to other logged-in players; this lets you
communicate with your fellow players without the audience hearing or
seeing it. You can whisper to an individual player, a number of players,
or to all logged in players present on the same stage as you. You can also
whisper to players on other stages, but you must use their usernames, and
there is currently no way to whisper to a player who is in the Workshop
and has no stage open. Note that you can have multiple stages open at the
same time in different browser tabs or windows, and you can have the
Workshop open as well as a stage or stages.
Typing a whisper command incorrectly displays a “how to” message in
your chat
field. If messages are not delivered to users (due to misspelling a
username, or a user not currently being online), the whisper "bounces"
and informs the sender what went wrong in the chat field.
Commands:
T o whisper:
to a single player
to multiple players
to all users on the
current stage

T ype:
/wh username1=Message
/wh
username1,username2,username3=Message
/wh *=Message

Note - /whisper works exactly the same as /wh but obviously it's easier
to just type /wh

23

11. DRAWING
Clicking on the “draw” button in the control panel reveals a different
set of tools – the Drawing Palette. You can be still holding an avatar
while you are drawing and can speak, but you won’t be able to move
your avatar on stage. Clicking on the “act” button will return the
Wardobe, Mirror and Controls so that you can operate your avatar.
Drawing allows you to draw
directly onto the stage, in
one of four layers; the
layers correspond to the
four boxes on the right
hand side of the drawing
palette. Click on the red
pencil icon to select a layer
to draw in. T he black
border shows which layer
you have selected; a pale
blue border indicates that another player is holding that layer. If you
select a layer with a blue border you will “steal” it from the other
player. T he top box will draw on the top layer, obscuring avatars. T he
next two layers will let you draw amongst the avatars, and the bottom
layer draws behind the backdrop.
Click on the eye to hide or show your drawing. Click on "clear" to erase
the all the drawing from that layer. Note that it is currently not
possible to erase only part of the drawing in a layer.
T he slider in the layer box controls the transparency of what has
already been drawn in that layer: move it to the left and the drawing in
that layer will become more transparent; move it all the way to the
left and it will vanish completely. T his is useful for fading prepared
drawing in and out.
T he colour picker at the top has three sliders, letting you adjust the
colour of what you’re about to draw. Move the sliders to change the
hue, and the new colour appears in the square to the left of the
sliders.
T he slider immediately below the colour picker controls the
transparency of what you are about to draw (use the slider in the
layer box to change the transparency of something you’ve already
drawn).
T he circle and slider below
the transparency slider
control the size of your
brush. Move the slider to
the right and the circle will
increase in size, indicating
how big it will appear on
stage. Move it to the left
to make it smaller.
Currently it is not possible
to erase, other than to
clear everything in a
particular layer. If you are
trying to draw a curved line and finding that it appears as sections of
straight lines, you are moving your mouse faster than UpStage can
keep up with; try drawing slower for smoother curves.
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If you want to draw a completely straight line, hold the shift key down
while you draw the line.
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12. AUDIO
Prerecorded MP3 audio files can be uploaded and played in UpStage.
Click on the yellow "audio" button to reveal the Audio Palette. Audio
files assigned to the stage will appear in a list on the right, with musical
notes indicating music tracks and "sfx" indicating sound effects. Use
the green arrows to scroll up and down if there are more than six
tracks assigned to the stage.
Click on a track
and its file name
will appear in one
of the three slots,
where you can
start, pause and
stop individual
tracks, set looping
and control the
volume with the
slider.
You can stop all
tracks at the same time using the "stop all" button.
Click on the blue "act" button to return to the avatar tool palette.
(Your avatar can still speak and move when you have the audio palette
open).

KNOWN ISSUES
At the time of writing (November 2011), the list of files in the audio
palette is displayed in a random order. T his is not very helpful if you
have a lot of audio files assigned to one stage, as you have to scroll
up and down to find the file you want. We hope to have the list
alphabeticalised in the next release (v2.4.1).
T here is also a known bug with being unable to stop a looping track, if
after you have set it playing and looping you fill up the other two
tracks and then add a fourth. T he fourth track will replace the first
looping track, but it won't stop it. "Stop all" will also not stop it. T he
only solution is to reload the stage. T his bug has been lodged on
SourceForge and we hope to fix it soon, but in the meantime the
workaround is to be careful not to select a fourth track when the first
one is still looping.
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13. WEBCAMS
Players wanting to use live video in UpStage will need to have a web
cam and a separate application that allows the player to FT P their
video to the server as motion JPEGs.

WEB CAM FTP SOFTWARE
FT P freeware or shareware is available for the major operating
systems. T heoretically any web cam FT P application should work,
however the following software has been researched and tested for
compatability with UpStage. Please note that this is by no means all
the available software, and as time passes there will be more and
better options.
T he main features that we have looked for in web cam FT P
applications are:
ease of use;
free or cheap, with no advertising on the image;
the ability to resize the web cam image to custom sizes;
any special effects are a bonus.
Please scroll down this page for screenshots showing how to configure
the applications listed below.

Recommended Webcam FTP Software
Windows: Fwink

Fwink (version 0.9.95 beta) is free, has no ads, allows customised sizing
and has some special effects including text messages and overlay
images.
http://lundie.ca/fwink/
Mac: Evocam

"EvoCam is the ultimate webcam software for Mac OS X. Use EvoCam
to publish a webcam with streaming video, view and record video from
network cameras and video servers, create timelapse movies, or use it
as part of your home security system with its configurable motion
sensors - these are just a few of the things you can do with this easyto-use yet incredibly powerful webcam software!"
Evocam is not open source, and it's not free (but it is pretty cheap!)
but at the moment it seems to be the most reliable and featuredpacked webcam ftp app for Mac. It has useful features such as
customisable sizing of the window and a variety of effects.
http://www.evological.com/evocam.html
Linux: Camstream

CamStream is a tool for webcams and T V grabber cards that allows
for streaming video from multiple video sources. It can save and/or
upload (FT P) timed snapshots. It provides a GUI frontend to control
the video devices.
http://freshmeat.net/projects/camstream/

Web Cam FTP Configuration
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Once you have chosen and installed the appropriate web cam
software, you will need to configure it to send the web cam images to
your UpStage server. Following are the settings you will need:
Host: URL of your UpStage server
username: (set by your UpStage administrator)
password: (set by your UpStage administrator)
filepath: filename.jpg
Port 21 (or other, set by your UpStage administrator)
Before you begin to upload your web cam image to UpStage, check
the pixel size, bearing in mind that images increase in size when they
are uploaded as avatars to UpStage. If it is 320 x 240 or larger, it will
take up half the stage or more, and impact on the speed and
performance of UpStage for everyone. We strongly recommend using
a web cam FT P application that allows you to scale your image to any
size.
You will need to set a trigger that tells the application how often to
take a new image; we recommend 2-3 seconds, as any faster is likely
to be faster than the image can travel from your computer to the
server and out to the other players and audience.
Once you have configured your web cam and are sending a live stream
to your UpStage server, you should be able to find the filename of
your web cam stream in the list of available video streams in the "Add
a new avatar" section of the workshop. You can then create an avatar
using that stream, and assign it to a stage in the "Manage stages"
section. Use it on the stage as you would a normal avatar.
Passive or active?

You will need to set the FT P upload to passive or active (not passive)
mode according to the configuration of your server. We have recently
had issues which suggest that this setting will also vary according to
your client computer's platform: with the new (2010) UpStage server,
we have discovered that Fwink on Windows needs to be in passive
mode to work, whereas Evocam on Mac and Camstream on Linux do
not work in passive mode, and need to have this option toggled off.
If you are having trouble with web cam FT P, the first thing to try is
toggling passive mode.
Fwink configuration:
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Evocam configuration:
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Camstream configuration:
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THE WORKSHOP INTERFACE
Once you have logged in to UpStage, you arrive at the Workshop,
from where you can either proceed directly to the Stages to rehearse
or perform, or choose from a range of administrative options. T hese
options allow you to create and manage Stages and Players, and
upload and manage Avatars, Props, Audio and Backdrops.

T he Workshop screen is an HT ML page and can be manually updated
by an UpStage administrator to include direct links to the stages you
are currently working on and notices for other players using this
UpStage server (as shown in the above screengrab, in the right-hand
column).
T he text links at the top and bottom of the page are also
customisable; this screengrab shows links to the Foyer
(http://upstage.org.nz:8084/), the Avatar Body Collision web site
(http://www.avatarbodycollision.org/), the UpStage web site
(http://www.upstage.org.nz), a log-out link and "Stages". T he "Stages"
link gives a list of all the stages on this UpStage server, from which
you can click on a stage name to enter that stage. You can also see
how many players or audience are on each stage.
"Guest" player log-ins allow access this list of stages, not the whole
Workshop interface. From here guests can click on a stage and have
full access to the on-stage player tools, but because they don't access
the Workshop they can't upload media. Guest log-ins are usually used
in introductory workshop situations, to prevent people from uploading
media before they know what they are doing.
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15. CREATING AND MANAGING PLAYERS
From the main Workshop screen, under the heading "Players", you
create new players and manage existing ones. You must be a
superuser to add new players, manage players other than yourself, or
remove players.

Changing your password
If you are not a superuser, the "Manage Players" link will only allow you
to change your own password. If you have been given a generic
password, it is recommended that you change this to something more
secure and memorable when you first log in.

Add a new player
Create a log-in for a new
player, and set their
permissions:
Act: this gives access
to the on-stage player
tools, but not to the
Workshop interface.
Administer: this gives
access to the on-stage
player tools and the
Workshop interface.
Add or Remove
Players: this is the
super-user, who can
do pretty much
anything.
The status of the player also
regulates the uploadable file size:
Act: no access to Workshop.
Admin: 1 MB
Superuser: 2 MB
However files of this size would not normally be necessary; the larger
the files, the longer a stage will take to load. Please refer to the Graphics
section for further information about file sizes.

Manage players
If you are a superuser, you can:
create new Player log-ins;
change any Player’s username, password and permissions;
delete Players.
From the Workshop, click on the link “Manage Players” and select the
Player you wish to manage from the list of Players. Make the desired
changes and click ok.
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16. CREATING AND MANAGING STAGES
"Stages" are web pages on which UpStage performances take place.
An UpStage server can have any number of stages, and media
uploaded to the server can be assigned to multiple stages. You can
also be "in" more than one stage at a time, simply by having different
stages open in different browser tabs.

SET UP A NEW STAGE
To create a new stage, click on the link “Set up a new stage” and give
your stage a name. This name will appear in the list of existing stages. It
won’t be accessible to audience members until you make it public in
some way (for example, create a link to it from the Foyer, put it on your
own web site or email the URL to your target audience), but it will be
visible to logged-in players and can be accessed for rehearsals or
closed performances.
The URL for a stage is http://yourserverURL/stages/stagename – for
example, http://upstage.org.nz:8084/stages/swaray. You can create a link
directly to a stage from the Foyer or from another web site by editing the
HTML just as you would create a link to a web page.

MANAGE STAGES
From the Workshop, click on the link “Manage an existing stage”; you
will see a list of stages, and if any players or audience are on a stage it
will be shown here (numbers of players/audience to the right of the
stage name).
T his is where you can:
assign and unassign avatars, props and backdrops for an existing
stage;
rename the stage;
edit the splash screen message for a stage;
change the background colour for the backdrops and props
galleries (useful if you have props or backdrops that are mostly
white and difficult to click on with a white background);
make the debug messages display on the stage (useful for
programmers trying to trace bugs!);
reset the stage;
delete unwanted stages.

Delete a stage
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To delete a stage, select the check box beside the stage name, scroll to
the bottom of the list and click the "remove selected stages" button. Note
that deleting a stage does not delete the media assigned to that stage.

Manage (edit) an existing stage
To manage (edit) a stage, click on its name. Note that if you edit a stage
while there are other people on it, the stage will automatically reload for
them. UpStage will try to stop you from doing this with messages
warning you that other people are using the stage; you can override these
messages. It is courteous to do this only when the people on the stage
know that it's going to happen.

Assign media to a stage

Select the stage you wish to edit then follow these steps:
1. select which users' media you want to see by clicking on the
check box by the username and clicking the "Display Media"
button;
2. below the "Display Media" button, click on the username or the +
sign to expand the list of media uploaded by that user;
3. select the media you want to assign to the stage by clicking in the
check boxes beside the thumbnails (note that media uploaded as
.swf will not display a thumbnail image, but you can identify it by
its name; clicking on the name will take you to that media's
information screen, so that you can be sure it is the media that you
want); then click "Save changes";
4. after clicking "Save changes", the screen will refresh, telling you
that the stage has been updated and giving a direct link to the stage
near the top of the screen. The avatars, backdrops and props you
have assigned to the stage will now appear in the Wardrobe and
Image Gallery of that stage (see Section 3.3).
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Change name and splash screen message

From the Edit Stage screen you can also edit the name of the stage,
and the splash screen message that will appear while the stage is
loading, T ype the new text in the appropriate places and click "Save
changes".
Change background colours

T o change the background colour of the backdrops and props
galleries, use the colour picker that is below the list of usernames. Click
on the colour you want (it will display in the box below the colour
picker) and click "Save Background Colour". T his change is only visible
to players, as the audience do not see these tools, and the main
reason for wanting to do it is if your performance has backdrops that
go behind the backdrop and prop galleries and make it difficult to see
and select the icons.
Note that, in the future, it will be possible to change other background
colours here too, including the chat window and the background colour
for the entire web page behind the UpStage stage.
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Debug messages
Click the check box "Turn Debug Messages On/Off" and click the "Save"
button alongside it. The main reason for doing this is programmers wanting
to find bugs, however it has also been used deliberately during
performances.
Reset

To reset the stage, click the check box beside "Reset the stage" and click
the "reset" button alongside. This clears all the text from the text chat
window and returns the stage to its default state; note that it does NOT
unassign the media that has been assigned to the stage, but it will restore
any changed avatar names to their original name.
If you change the voice of an avatar that is assigned to a stage, it is
necessary to reset the stage in order for the changed voice to take
effect.
If you need to reset the stage during a rehearsal for some reason,
remember to warn everyone that you are doing this, as they will be
"thrown off" the stage. The stage will automatically reload, but it can be
disconcerting if you aren't expecting it and is definitely not a good idea
to do during a performance (unless specifically you want that effect!).
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17. UPLOADING MEDIA
Before you begin uploading your media to UpStage, please read the
section of this manual "Creating Media".
Media (graphical avatars, props and backdrops, and audio files) is
uploaded to UpStage via the Workshop interface. We are currently
developing a new interface, as the current system was not designed
for the numbers of artists now using UpStage and has become quite
cumbersome. We ask for your patience, while we wait for the new
system to be ready.
Unless you are a superuser, media uploads are limited to 1MB per file;
this is to help avoid the uploading of unnecessarily large files, which will
mean that stages take longer to load. Players with superuser
permissions can over-ride this limitation.

AVATARS
In the Avatar section of the Workshop, you can upload new avatar
images and video streams, delete unwanted avatars, listen to available
voices and change an avatar’s voice.

Uploading a new avatar
Avatars can be:
still images in .jpg, .png or .swf format
multi-frame avatars
animated .swf files
motion jpegs from a web cam.
A single avatar can be composed of all .png files, or all .jpg files, or a
single (possibly animated) .swf file. Multi-frame avatars can have a
maximum of 10 frames (images), all of which must be the same format
(either .png or .jpg). T here are a number of tricks that will help to
achieve the best avatars - see the section on Creating Media for tips
on creating graphics for UpStage.
Once you have created your avatar in a graphics application, click on
“Add a new avatar” in the Workshop; give it a name (every avatar
must have a unique name – UpStage will add a number if you give an
avatar the same name as another avatar) and browse to the file(s) on
your hard drive. Click OK and the file(s) will be uploaded to UpStage,
and you will see the avatar’s edit screen. T his is where you can select a
voice for your avatar (see the chapters on Speech and T ext Chat for
more information about the voices available on UpStage, and the
appendix on T ext2Speech Voices for information about how to add
more voices).
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If you are creating a new web cam avatar, you will first need to set up
your web cam with FT P access to your UpStage server (see the
Webcams chapter for details and recommended software). Once your
image or video stream is ready, follow the link from the Workshop to
“Add a new avatar” and find your filename in the drop down list of
available video streams. Choose a name for the avatar then click OK.
Go back to the Workshop and follow the link to “Manage Avatars” and
you will see a list of the stages, plus "unassigned" – this is where you
will find your avatar before you have assigned it to a particular stage.
It will also appear in the list of avatars uploaded by you when you are
in the "Manage Stages" section, allowing you to assign it to a particular
stage. Note that there is no limit to how many stages one avatar (or
other media) can be assigned to.

Manage Avatars
T his screen lets you access information pages for all the avatars on
the server, grouped according to the stages they have been assigned
to, plus an "unassigned" category for avatars that have not yet been
assigned to a stage. Click on a stage name or "unassigned" and then
on the name of an avatar to go to that avatar's edit screen.
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You will see a thumbnail image of the avatar, information about the
file, and a dropdown list of available voices. You can change the name
of the avatar and its voice, and test the voices to see what they sound
like.

PROPS
Props function in a similar way to avatars, but they can’t speak, and
you must be holding an avatar in order to hold a prop. When an avatar
is holding a prop, it appears on stage at the top left corner of the
avatar. If another player clicks on the same prop, it will appear to be
passed to the second player’s avatar. Invisible avatars are useful for
placing props on the stage, appearing independently of the visible
avatars.

Uploading a new prop
Props are created in the same way as avatars, and should be still
images in .png or .swf format; see Section 4 for recommendations
about creating graphics for UpStage.
From the Workshop, follow the link to “Add a new prop”, and navigate
to the appropriate file on your hard drive. Choose a name for it and
click OK to upload.

Manage Props
T his screen shows a list of available props, grouped according to the
stages they have been assigned to; you can change the prop name,
and delete unwanted props.

BACKDROPS
Backdrops can be still images in .jpg, .gif, .png or .swf format. See the
section Creating Graphics for recommendations about creating
backdrops for UpStage.

Uploading a new backdrop
From the “Add a new backdrop” link in the Workshop, navigate to the
appropriate file on your hard drive. Name it and click OK to upload.
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Manage backdrops
T his screen shows a list of available backdrops, grouped according to
the stages they are assigned to; you can change the backdrop name
and delete unwanted backdrops.

Multiframe backdrops
Multiframe backdrops work in the same way as multiframe avatars –
see section 4 Graphics for more information about creating multiframe
backdrops. T o change the frame of a multiframe backdrop on stage,
the command is /b 1, /b 2 etc. and /b 0 to animate the frames.

AUDIO
You can upload MP3 files and assign them to a stage. Up to three
audio tracks can be played at simultaneously on a stage (more than
three can be assigned to a stage).

Uploading a new audio file
From the "Add new audio" link in the Workshop, navigate to your MP3
file on your hard drive. Name it and select either "Sound effect" or
"Music" then click OK to upload.

Manage audio
T his screen shows the list of audio files that have been uploaded. You
can delete files, or click on the file name to edit its information – you
can change the name or the type of file (sound effect or music).
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18. CREATING GRAPHICS FOR UPSTAGE
Avatars, backdrops and props for UpStage can be created using standard
graphics applications such as Gimp, PhotoShop, Fireworks and Flash.
The recommended formats for your original graphics files are .swf or
.png.
Vector-based images will appear much cleaner than pixel images (such
as .gif and .jpeg), as they are resized to match the dimensions of
individual screens and browsers. You can use .gif and .jpg but your
images will lose quality (note – backdrops are fine as jpegs).
Avatars and props will appear on stage approximately two to three times
larger than the original file. This is because the stage is not in a fixedsize window: it allows for different screen resolutions and sizes, and
different sizes of browser window. The aspect ratio is 7:3 (see the
backdrop diagram below).
The recommended size for the original file for a “standard” sized avatar
is approximately 100x100 pixels – obviously you will want bigger and
smaller ones but this gives you somewhere to start. In order to test the
size of your avatar, you must upload it, assign it to a stage, then look at it
on that stage (the same applies to props, and also for backdrops if you are
working out what is going to be obscured by the chat window).
It can be a time-consuming process getting your graphics to the size you
want, so it’s a good idea to make a couple of samples first and then base
the rest of your graphics on those once you have got them the size you
want (this applies to both props and avatars). If you upload avatars that are
not the right size, please remember to delete the unwanted files ,
otherwise the server and Workshop interface get clogged up with
unwanted media.

CREATING .PNGS
The .png file format is recommended for avatars and props, rather than
.gif or .jpg, as it allows for transparency and gives a good quality image.
Files can be saved in .png format in most graphics applications. In the
File menu, choose "Save As" and look for the .png option.
Do NOT interlace the file when you save it.

CREATING .SWFS
Although UpStage itself is open source and we've done everything we
can to make it cross-everything, it is ultimately delivered to the browser
via the Flash Player plug-in1 ; because of this, the most successful
graphics format is .swf. To create .swf files, you need the Flash
application (note: open source applications that convert other formats to
.swf are beginning to be available - if you know of something that works
well, please let us know!).
Please note that the following information is by no means a comprehensive
Flash tutorial. If you do not know how to use Flash at all, or if the following
steps are not clear to you, we recommend that you look on the web for a
Flash tutorial.
The basic steps for producing a single frame avatar or prop using Flash
is as follows:
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Start with a .png file in which you have clear-cut your image and
given it a transparent background. Keep the .png image at a large
size – around 500px square for a standard-sized avatar is a good
guide, as much larger will result in an unessarily large .swf file but
a smaller file will start to lose quality.
Open Flash and from the File menu, choose Import; navigate to
your .png file and import it into Flash.
Click on the image to select it – a grey border appears around it.
In the Insert menu, choose "Convert to symbol" – the border will
change to a thin blue line.
Then resize it (Modify > Transform), remembering that avatars and
props will increase in size by about 2-3 times when uploaded into
UpStage. Around 100 pixels is a good size to begin with if you
don’t know what size you want.
Once you have reduced it to the required size, adjust the document
size to match.
From the File menu, choose Export Image. Put the jpeg quality up
to 100% and save the .swf file.

ANIMATED AVATARS AND PROPS
UpStage supports both animated sequences and Flash movie clips. When
you put sequenced (frame-by-frame, or motion or shape tweened)
animation onto the stage it will appear static with the image in the first
frame (/a 1). To change to other frames of the animation, type /a 2, /a 3,
etc. To make the avatar animate, type /a 0.
If you have saved your .swf as a movie clip animation it does not need
any commands, it will automatically loop and can be used on stage either
as a continuously looping animation or as a series of still avatars that are
swapped using the /a command, as above.
Props and backdrops can also be animated using Flash. But bear in mind
that Flash animations can end up as larger files, which will increase the
time it takes to load your stage.
To create an animated sequence, follow these steps:
First create a series of .png files (as above) and give them
numbered filenames.
Open Flash and from the File menu, choose Import and navigate to
the first .png file; Flash will ask if you want to import the series,
say yes. This will create a frame for each image.
Going to each frame in turn, click on the image to select it (a
border appears around it), in the Insert menu, choose "Convert to
symbol" (the border will change to a thin blue line) then resize
(Modify > Transform), remembering that avatars and props will
increase in size by about 2-3 times when uploaded into UpStage.
Once the images are all reduced to the required size, adjust the
document size to match; if your images are not all exactly the same
size make sure you have made the document size as big as the
largest image.
From the first frame, and with the image selected (the blue line
should appear around it), go to the Insert menu and select “Create
motion tween”.
To check that the tweening has happened, go to the Control menu
and hit play – your sequence of images should play.
From the File menu, choose Export Movie; put the jpeg quality up
to 100% and save the file.
Sounds can be embedded into Flash movie clips, but it takes a bit of
trickery to be able to control the sound.
When using Flash to create animated avatars and props, be sure to check
the the frame rate and whether it is set up to loop. If the frame rate is, for
example, 24 fps and it is set to loop, the image will reload 24 times a
second, regardless whether anything else is changing on the screen.
Making your still flash pictures run at, for example, 1 fps and/or
switching off looping will ease the load on everyone’s browser. Very
slow animation, for example tweened over 40 or so frames and looping,
will cause the least strain and can create some very effective movement.
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UpStage doesn't cope with movie clips nested within the frames of a
Flash animation, but it is possible to import Quicktime movies into Flash
and then export as a .swf. You will need to experiment with file sizes and
perhaps remove some of the frames from the Quicktime movie in order to
keep the size down.
Once again, this manual does not pretend to provide a comprehensive Flash
tutorial. Please look on the web for more detailed information on using
Flash.

BACKDROPS
As long as the original image is 380x240pp or larger, a backdrop will fill
the UpStage screen, including going behind the text chat window. The
text chat window has a white background in order to ensure that text is
always readable, even over busy backdrops, but this means that the area at
the right of your backdrop is covered by the chat window. You may wish
to create a backdrop that has a blank area on the right where the text chat
window is to ensure that important parts of your backdrop are not hidden
behind the chat window.
The proportions of the whole image are:
total width : total height - 10 : 6.2
width of stage area : width of chat area - 7 : 3
minimum width : height – 380 : 240 pixels
This diagram illustrates the proportions of the stage and chat areas (bear
in mind that everyone’s screen size and browser window size can be
different – your backdrop will stretch to fill the space):

Note that in the Player view of the stage, an strip along the bottom of the
backdrop will be obscured by the Backdrop and Prop Image Galleries –
but as these tools are not seen by the audience, it is recommended that
your backdrop extend below that strip. (TIP: it's a good idea to look at
your stage in audience view as well as player view; you can do this
while you're working by having it open in two browsers, one where you
are logged in and one not.)
Backdrops can be created as .png, .swf, .gif or .jpeg; as with avatars and
props, .png or .swf will give the best quality results. Note that .png files
should NOT be interlaced when saving. If you are using .gif or .jpeg,
upload a test backdrop to see if it’s going to be good enough, and
remember to delete unwanted images.
When uploading a series of backdrops for a particular show, it’s a good
idea to give them names that begin with the show name, so that when it
comes to assigning them to the stage, they are displayed together in the
list. This applies to props and avatars as well.

FILE SIZES
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File sizes are limited according to your user permissions: superusers can
upload up to 2 MB per file, admins can upload up to 1 MB per file;
however this is still quite big and in general you should try to keep your
files small. The larger the files you upload, and the more graphics
assigned to your stage, the slower the stage will load. Performance after
loading may also be affected, although so far it seems that the most
noticeable impact is during the initial loading of the stage.
What is a “reasonable” file size for your original graphic? This is very
hard to say, as it’s completely different for a small static flat graphic
prop which may be only 1K, and an animated flash backdrop or multiframe
avatar, which could be over 500K. And a stage with a single large
graphic may load faster than one with many medium sized graphics.
If your original files are larger than 500K, check whether you can resize
them and save them again to a smaller file size. Remember that screen
resolution is only 72ppi so there is no need for your originals to be at a
higher resolution.

DELETING GRAPHICS
It is important to delete unwanted graphics in order to keep the workshop
area manageable. This is done through the “Manage avatars”, “Manage
props” and “Manage backdrops” screens. Check the box beside any
images that you want to delete then scroll up or down and click the
“delete selected” button.
You can see on these screens whether an image is currently assigned to a
stage; if you try to delete an image that is assigned to a stage, UpStage
will ask if you are sure that you want to delete it. If multiple groups are
using the same server you should not delete anything unless you are sure
no-one else is using it (for example your own test graphics that you no
longer want).
If you are working on a server that is used by various people, such as the
Open UpStage (http://upstage.org.nz:8084) please do not delete anything
that has been uploaded by someone else. But also be aware that we
operate a Creative Commons policy, so your media may be "borrowed"
by others. No-one should use someone else's media in a performance
without the original creator's permission.

ON-STAGE LINKS
Active hyperlinks can be created by typing a URL into the text chat
window, eg http://www.upstage.org.nz. Use right-click or ctrl+click to
use the link, which gives the options to open the link in a new window,
the same window, or to copy the link.
Sometimes it’s useful to have a graphic on-stage that provides a
hyperlink to another stage or a different web site. The way to do this is to
create a .swf image with an ActionScript button containing the following
code:
on (release) {
getURL("http://desired.url", "_self");
}
This could be an avatar or a prop that is placed on the stage at the time
that you want the audience to follow the link.

MORE FLASH TRICKS
If you are experienced in using Flash and Actionscript, you can do a lot
more with it in UpStage; most (but not all) interactivity that can be
achieved in a web page using Flash, can be achieved in UpStage. T he
purpose of this manual is not to teach you how to use Flash, but there
are some relevant tutorials on the UpStage web site which you may
find helpful.
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1. An open source equivalent plug-in, Gnash, has recently become
available, but it is a media player browser plug-in, not a graphics
application; and at the time of writing, appears to be unfeasible
for using with UpStage as in its current state it is incompatible
with many of UpStage's features. We are also looking into
HT ML5 as a possible future solution.^
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19. CREATING AUDIO FOR UPSTAGE
As well as sound created in real-time by avatar voices, prerecorded
MP3 files can be uploaded to UpStage and played via the Audio palette
in the on-stage player tools. Prerecorded audio could include music,
sound effects, human voices, etc. At this stage, ONLY the MP3 format
works (a third possibility for adding audio to your performance is to
embed audio in a Flash animation, if you have the skills and ability to
do this).
A 1MB file size limit for audio uploads is in place on the UpStage Open
Server (8084); this is to ensure that the server doesn't get
unnecessarily filled up with enormous files, and that stage load times
are not too long and tedious for the audience. Remember that when
the audience enters your stage, all of the media you have assigned to
the stage will be loaded to their computer before they arrive at the
stage; therefore the bigger the files, the longer the load time.
T here are many ways to create, convert and compress MP3 audio files;
we recommend that you refer to other manuals for more information
on this if you are not familiar with it.
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20. GLOSSARY
Here are definitions for some of the terms that are used in this
manual. Please let us know if something is missing.

Audience: people present online at a performance, but not logged in.
T he audience can participate via the text chat, but do not have access
to the same tools as the players.
Avatar: a graphical icon that can be held and moved around the stage
by a player, and that can speak.
Backdrop: a graphic which fills the stage behind any avatars and
props that are placed on it. A backdrop can also extend behind the
text chat.
Chatters: the online audience are often referred to as “chatters”, as
they contribute to the performance via a text chat function.
Cyberformance: live online performance where remote players and/or
audience use internet technologies to come together in real time.
Drawing: functionality that allows real time drawing directly onto the
stage.
Foyer: the home page of an UpStage server – where the audience can
come to see what's on, and where players can log in.
Mirror: the square on a stage that shows a Player which avatar they
are currently holding.
Palette: e.g. "drawing palette" or "audio palette" – a set of tools for a
particular function.
Player: a logged-in participant in a performance. Players have access
to on-stage tools which allow them to manipulate avatars, backdrops
and props.
Prop: a graphic which can be held by an avatar or placed on the stage.
Splash screen: a sort of "curtain" that appears over the stage while it
loads; the splash screen has a bar to indicate how far through loading
the stage is, as well as a welcome message which you can edit and the
name of the stage.
Stage: a dynamic web page where you can place and move avatars,
props and backdrops to create a performance.
Stage tools: tools visible on the stage to logged-in players (but not
visible to the audience) that enable the players to manipulate media on
the stage in real time.
Text chat: an input field and text chat window, where avatars’ speech
and audience text appears and is visible to everyone; the text chat
window can be scrolled up and down to read text that has been
entered previously.
Tools: the buttons, sliders and icons that allow logged-in players to
manipulate media.
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Wardrobe: the interface through which players can select avatars on a
stage; an alphabeticised and scrollable list of the icons and names of
the avatars assigned to that particular stage.
Whispering: silent text communication between logged-in players that
is not visible to the audience.
Workshop: the “back stage” interface where logged-in Players can
upload graphics, view existing graphics, create and manage stages and
manage players.

52

21. / COMMANDS
When you are on stage, there are a number of commands you can type into
the text field to do certain things:
/a 1, /a 2 etc
/a 0
/as ize

/b 1, /b 2 etc
/b 0
/details
/help
/info
/nick
/licens e
/ps ize

/whis per or /wh
:
!

displays a different frame of an animated or
multiframe avatar
animates a multiframe or animated avatar
/asize followed by a number will adjust the size of
the audience text in your chat window (note – this
only affects your own screen; the text size will not
adjust for the audience or other players); the default
size is 4. Audience can also use this command to
adjust the size of font in their browser.
displays a different frame of a multiframe backdrop
animates a multiframe backdrop
lists the usernames of all players and the number of
audience members who are present on that
particular stage.
gives you a list of some of these commands
shows information about UpStage including which
version of the software you are using
allows you to change the name of the avatar you are
holding – type /nick newname
provides information about the dual GPL and
Creative Commons license
/psize followed by a number will adjust the size of
the player text in your chat window (note – this
only affects your own screen, the text size will not
adjust for the audience or other players); the default
size is 4. Audience can also use this command to
adjust the size of font in their browser.
allows you to communicate with other players
without the audience being aware; the whisper
command is explained in Section 1.5
typing : before your text will give you a silent
thought bubble, rather than a speech bubble and
spoken text. The text is blue in the chat window
typing ! before your text will make your avatar
shout. The speech bubble outline and the chat text
is red.
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22. TEXT2SPEECH VOICES
UpStage’s speech is generated by the Festival Speech Synthesiser,
developed at the Centre for Speech T echnology Research at Edinburgh
University (http://www.cstr.ed.ac.uk/projects/festival/).
An avatar's voice is selected from a dropdown menu when adding a
new avatar and changed in the "Manage avatars" section (see section
3.2.3). T here are currently about 100 voices on the UpStage server
(http://upstage.org.nz:8084); if you are setting up your own UpStage
server, please see the technical documentation regarding installing
voices.

VOICES CURRENTLY AVAILABLE ON UPSTAGE
T he voices currently available with UpStage have a filenaming system
that describes what kind of voice each one is. Some of the voices
speak English in a foreign accent, some speak English in various English
accents, and some are designed to speak other languages. T he
software defaults to a male voice, but we have endeavoured to make
female versions of most voices.
You can test the voices on the Avatar Edit screen, by selecting
different voices from the drop down menu and entering the text you
want to test.
T he format is: ["e" or "emb"] _ [native language] - [en] - [modifications]
For example:
e_de – speaks and reads German
e_en – speaks and reads English
e_en-fast-f1 – speaks English quickly, in a female voice
e_en-wm – speaks english in a west midland accent.
Other accents in the e_en series are "n" for north, "sc" for Scots, "rp"
for RP, "r" for rhotic (which means it pronounces the r in words like
church).
emb_af1 – speaks and reads Afrikaans
emb_af1-en – speaks English in an Afrikaans accent
emb_de4-en-low-slow – speaks english, lowly and slowly, in
a german accent
We are in the process of compiling descriptions for all the voices;
following is the information so far:
NonEng

Voice

Male Female Accent

awb_cmu

X

Scottish

Soft, slightly muffled

awb_nitech

X

Scottish

Clear, not very deep

bdl_cmu

X

English?

bdl_nitech

X

English?

A little bit quavery
Firmer than bdl_cmu, a bit higher, but
clearer

bud

X

clb_nitech

NZ?

Deep, calm

X

NZ?

Robotic, soft

X

NZ?

Smooth, young

NZ?

fast, boyish

crunchy

Crunchy - good for witches & effects

default
e_en-fast-f1

54

Descript ion

X

e_en-r-f3

X

NZ?

fast, boyish

e_en-wm-slow

X

Australian??

e_en-wm-slow-f3

X

Australian??

nasal drawl
boyish nasal drawl, computerish & like a
learner-reader reading

e_eo

X

emb_de4

X

German

emb_de4-en

X

German

emb_de4-en-low-slow X

German

emb_de5

X

German

emb_de5-en
emb_de5-en-highslow

X

German

X

German

emb_de7

X

German

emb_en1-high

X

English

soft mid-range male voice

emb_fr1-en-low

X

European

emb_fr4-en-high-slow X

European

low & lecherous
mid-high male voice, sounds like he has
trouble speaking
low soft female voice with slight European
accent

emb_hu1-en-slow

foreign

X

emb_nl2

X

emb_nl2-en

X

emb_pl1

German slow low somewhat distorted voice
slow high somewhat distorted voice,
English w/German accent
mid-high slightly strangulated male,
English w/German accent
middle somewhat slow and drawn out
German male, German

European?
Dutch

mid-low male
mid-low male voice with slight European
accent

Polish?
Polish?

mid-low calm female
mid-low calm female with European
accent

Swedish?

mid-low male speaking quickly

X

Swedish?

mid-high female with European accent

X

Computer

boyish computer monotone

European?
X

emb_pl1-en

German neutral German male
mid-range, clean, English w/German
accent
pimp's voice: low & lecherous (English
w/German accent)

X

emb_ro1-en

X

emb_sw1-en-fast
emb_sw2-en-highslow

X

high

X

rms-faster

X

American

rms-nitech

X

American

Deeper than roger, clear, little bit emphatic

roger

X

English

Thin, proper-sounding, not deep

slow

X

computer

gets slower & lower, very good for effects

slt-cmu

X

American

Flat, slightly muffly

slt-nitech

X

American

Flat, a bit clearer & stronger than slt-cmu

ADDING MORE VOICES
You can install additional speech plug-ins on your own server to extend
the range of voices available to the avatars. As long as you don't mind
messing around with the sourcecode a little bit it's not difficult –
Patricia Jung explains how she did it (for Linux, using UpStage V1 - note
that this is now several years old):
Just add another entry in the VOICES section in
Upstage/upstage/voices.py like:
# txt2pho/mbrola:
'de1': ("| /usr/local/mbrola/pipefilt | /usr/local/mbrola/preproc
/usr/local/mbrola/Hadifix.abk /usr/local/mbrola/Rules.lst |
/usr/local/mbrola/txt2pho -p /usr/local/mbrola/data/
|/usr/local/mbrola/mbrola /usr/local/mbrola/de1/de1 - -",
_fest),
I know, it looks awful but this is only because the command
is an awful chain consisting of four commands with a couple
of options each and the relevant path:
"| pipefilt ...| preproc ... | txt2pho ... | mbrola ..."
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It does some preprocessing (like exchanging all appearances
of "z.B." with "zum Beispiel"), then hands the resulting text
over to txt2pho and to mbrola.
As long as your command or command chain takes text
input from the standard input and outputs the result as
sound in raw format on the standard output chain (Unix
stuff, ask me if you haven't heard about it) you can put
whatever you like in between the "| and the ".
T he above mentioned awful command chain will work when
one has installed the txt2pho frontend; it uses the de1
female mbrola voice, and you can choose it in the web
interface using the name de1.
T he only problem with this kind of reconfiguration is: As
config.py isn't a nice configuration file but a python script
one needs to know at least that python is very picky about
vertical alignment: It's extremely important that your new
voice entries have the same amount of whitespaces at the
beginning of the line as the other voice entries.
T he reason it took me so long was T T S: I failed completely
and utterly in making the German festival extensions for use
with mbrola voices:
http://www.ims.unistuttgart.de/phonetik/synthesis/festival_opensource.html
work. T hen I tried txt2pho with mbrola:
http://www.ikp.unibonn.de/dt/forsch/phonetik/hadifix/HADIFIXforMBROLA.html
(http://bogmog.sourceforge.net/document_show.php3?
doc_id=34 has a nice installation description), ignoring
festival, and this worked at once.
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23. TROUBLESHOOTING
UpStage is a work in progress: it is being maintained and developed by
volunteer programmers, which means that things happen but
sometimes slowly, and sometimes things break as we go. We welcome
input from anyone who has the time and skills to work with us on the
development of UpStage - please visit the SourceForge site for more
information, and join the developer's list.
If you encounter a problem that isn't listed here, or that you still can't
find an answer to, please:
check the FAQ page on the UpStage web site, maybe there's an
answer there;
visit the bug tracker on SourceForge to see if it's something that
we're working on (if it is, please add comments as more
information can help to find a solution);
contact the UpStage team - we will try to help.

BROWSER PROBLEMS
We are constantly monitoring browser compatibility, so if you
experience problems connected to your choice of browser, please
contact us.
If you are having browser problems, we recommend the following:
ensure that you have at least version of the Flash player
installed;
close your browser window, open a new window and log in again.
If you still have problems after doing this, quit your browser
application and restart it.

STAGE WON’T LOAD
If the stage fails to load properly, and the splash screen remains over
the stage with the message “Couldn’t load all images”, this could mean
that there is a corrupted image assigned to the stage.
T he first thing to do is try reloading, as it could just have been a blip in
the data flow; either use the “reload” button on the splash screen, or
use the back button in your browser to return to where you can from
and click on the link to the stage again.
If this doesn’t work, you may need to remove a rogue image from the
stage. If you had just assigned a new graphic to the stage before you
encountered this problem, then that is most likely to be that one that’s
causing the problem. T ry unassigning that image from the stage, and
see if it will load.
If you don’t know which image it is, you may need to take everything
off the stage and reassign them one by one or alternatively, delete the
stage and make a new one.

FONTS LOOK BAD
If an .swf file has been saved as low quality (in the original file), it can
force the whole stage to appear “low quality”. T his can be changed by
right-clicking (on a Mac, ctrl+click) on the stage, and selecting “Quality”
from the menu that appears. If Low is selected, change it to High and
you will see that the fonts now display properly.
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However, this will only correct the problem on your machine; your
audience may not know how to change the quality. A better solution is
to work out which image is causing the problem, delete it and resave
the original file as high quality.

LINUX FONTS
If you are using UpStage on Linux you may find that fonts are not
appearing on stage. T his problem is fixed by installing additional
packages:
apt-get install gsfonts gsfonts-x11
and
http://www.macromedia.com/shockwave/download/download.cgi?
P1_Prod_Version=ShockwaveFlash&P2_Platform=Linux&P3_Browser_Version=Netscape4
untar/gzip
close all browsers, run the installer (see installation instructions
on the url above)

OTHER PROBLEMS
UpStage is a work in progress, and it is an open source development.
We use SourceForge to track bugs – please visit
http://sourceforge.net/projects/upstage/ to see what bugs and features
we are currently working on.
T he UpStage web site – www.upstage.org.nz – has FAQs and
notification of any immediate or temporary problems. Please check
there if you are experiencing problems.
If you have any other problems or suggestions, please contact us and
we will endeavour to answer your questions and solve any bugs.
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